Student User Guide
Pearson Humanities and Social Sciences
MyAnthroLab | MyArtsLab | MyHistoryLab | MyMusicLab
MyPoliSciLab | MyPsychLab | MyReligionLab | MySocLab

For quick navigation, click below:
- Getting Started with Your Course
- Course Navigation
- Training and Troubleshooting Resources
# TABLE OF CONTENTS

PEARSON STUDENTS: www.pearsonstudents.com ................................................................. 3  
BEST PRACTICE TIPS .............................................................................................................. 4  
REGISTRATION ....................................................................................................................... 6  
   How to Register .................................................................................................................. 6  
   Option 1 - Using Your Pre-Paid Access Code ................................................................. 10  
   Option 2 - Using a Credit Card or PayPal Account ......................................................... 11  
   Option 3 - Getting Access Without Payment for 14 Days ............................................. 12  
MyPearson PORTAL ............................................................................................................. 14  
GETTING STARTED .............................................................................................................. 15  
COURSE NAVIGATION ....................................................................................................... 16  
eText & Chapter Audio ........................................................................................................... 16  
Assignment Calendar ............................................................................................................ 18  
   Completing an Assignment from Your Assignment Calendar ....................................... 19  
   How the Study Plan Works .............................................................................................. 20  
Study Plans & Course Content ............................................................................................ 21  
Student Grades .................................................................................................................... 22  
Grades List Columns ............................................................................................................ 22  
   How to Locate Study Plan Grades ................................................................................. 24  
   How to Print a Copy an Assignment ............................................................................... 25  
Communication Tools ......................................................................................................... 26  
TRAINING AND TROUBLESHOOTING RESOURCES ....................................................... 27  
Student Troubleshooting Guide .......................................................................................... 28  
   1. Browser Tune-Up ........................................................................................................... 28  
   2. Accept Cookies and Clear Your Cache ..................................................................... 29  
   3. Advanced Settings Guide ........................................................................................... 30  
   Pop-Up Blockers ................................................................................................................ 31  
   Cookies ............................................................................................................................... 32  
   4. Security ....................................................................................................................... 32  
   5. Wi-Fi ............................................................................................................................. 32  
   6. Media (videos, etc.) Issues .......................................................................................... 32  
   7. 24/7 Customer Support ............................................................................................... 33  
   How to Retrieve your Pearson Login Name and Password ......................................... 34  
   How to Contact Pearson Customer Technical Support ................................................. 35
PEARSON STUDENTS: www.pearsonstudents.com
We invite college students to speak up and help us imagine, design, and promote exceptional educational products and services for the advancement of learning today and for generations to come. To this end, we have an entire site dedicated to our students.

Please visit www.pearsonstudents.com for more information on how to Get Involved with our Pearson Campus Ambassador Program, Pearson Free Agent, Pearson Student Advisory Board, Pearson Leadership Development Program, internships, and much more. Additionally, students can Get Stuff (MyPearsonStore) and Get Support (Tech Support, tutoring, etc.).

We believe in actively engaging with our students. In addition to Twitter, YouTube, and Pinterest, we maintain an active Facebook page, which includes our support materials.

To join our Facebook page, click here:

www.facebook.com/pearsonstudents
BEST PRACTICE TIPS

1. **Browser:** We strongly recommend that you use Mozilla Firefox for your browser. Firefox has proven to provide the most stable environment to date. Computers come standard with Internet Explorer for Windows and Safari for Mac. To use Firefox, you may need to download it. If you’d like to download Mozilla Firefox for free, click here: [http://www.mozilla.org/en-US/firefox/new/](http://www.mozilla.org/en-US/firefox/new/)

2. **Web Clutter:** Close all other applications and windows on your computer before starting your MyLab coursework.

3. **Personal Computer Settings:** Be mindful of your personal computer settings. Hibernation may cause an incomplete submission and could affect your grade. Be prepared to complete or properly save your in-progress assignments before stepping away from your computer.

4. **Internet Connection:** If you are using a wireless connection, please make sure that you have a strong and stable connection. If your wi-fi drops—even for a split second—it will cause an interruption in your work, which can result in an error. It is best to work via a hardwire connection.

5. **Error Messages or Functionality Issues:** If you experience any unexpected messages or functionality during a session of MyLab, please take the following steps:

   a. First, capture the timely **User and Session** information (see image below)—**just in case** you need to contact Customer Tech Support. Note that this is only useful during the same session. If you log out and log back into get the information, we will be missing the key data. From the various bits of information, we can reconstruct what happened more effectively and provide more timely support and resolution.

   ![](image.png)

   b. Before contacting Customer Tech Support, click on the **Troubleshooting Guide** within this User Guide. These instructions have been compiled from the top ten reported issues, so you will save valuable time by using this resource for solutions.
c. If your issue is not solved by the Troubleshooting Guide, use the captured **User and Session** information (see image above) and report the issue to **Customer Tech Support**.

d. **PLEASE DO NOT CONTACT YOUR INSTRUCTOR UNTIL YOU'VE CONTACTED CUSTOMER TECH SUPPORT.** Your instructor is not equipped to troubleshoot, but our 24/7 Tech Support will be happy to assist! Customer Tech Support will issue an **Incident Report number** in a confirmation e-mail. **SAVE THIS E-MAIL!** If you have not received resolution within 24 hours, please contact your instructor and provide the Incident Report number. (Your instructor can then submit the Incident Report number to the local Pearson representative for escalation.)

6. **On-Campus Computer Lab:** Consider completing your high-stakes coursework (assignments that count toward your grade) in an on-campus computer lab.
   - These computers will be hardwired, so you can eliminate unstable wi-fi concerns.
   - If you receive an error message or a functionality issue, the lab administrator can verify and provide proof to your instructor.
REGISTRATION
If you do not already have a MyLab/Mastering student account, you must first register as a student to create a unique log in and password.

Before you register for your MyLab, you will need to have the following:

- Valid email address
- Course ID from your instructor
- School zip code

How to Register
2. Under Register, click Student.
3. Confirm that you have the **3 Things to Get Registered**, and click on **OK! Register now >**.

4. Enter your instructor’s **Course ID**, and click **Continue**.
5. At this point, you have two options.

- **SIGN IN WITH YOUR PEARSON ACCOUNT:** If you already have a Pearson account, sign in by entering your existing username and password.

- **CREATE A PEARSON ACCOUNT:** If you do not have an account, click the Create link. Type in your information, such as valid email address, a username and a password. Then, review the Pearson’s End-User License and Privacy Agreement, select I accept the license agreement, and click Create Account.
On the next page, you will be presented with three options to continue with the registration process.

**Option 1 - Use an Access Code:** If you already bought your access code, either bundled with your textbook or as an access code kit sold individually, click **Access Code.** Enter your access code, one set of letters in each box, and click **Finish.**

**Option 2 - Use a Credit Card or PayPal:** Purchase instant access to your MyLab course via a credit card or PayPal account.

**NOTE:** Some courses provide the option to purchase with or without the eText. The integrated eText is a very powerful, flexible tool and, though you can buy the eText later, it costs less to buy the course content + eText as a package.

**Option 3 - Get Temporary Access Without Payment for 14 Days:** If you’re waiting for financial aid, this option grants temporary access to your MyLab for 14 days. At the end of 14 days, your temporary access will be suspended and you will be required to enter a prepaid access code or purchase access with a credit card or PayPal account to continue working in your MyLab course.

**NOTE:** Your course information will be listed on the right hand-side of your screen. If this is NOT your course, click **Enter a different course ID.**
**Option 1 - Using Your Pre-Paid Access Code**

If you have a pre-paid student access code, click on the **Access Code** button under **Use an Access Code**.

- On the Access Code page, enter your access code, one set of letters in each box, and click **Finish**.

Once your access code is processed, a registration confirmation page will appear. You are now registered and enrolled in your MyLab course. To get started, click **Go to Your Course**.
Option 2 - Using a Credit Card or PayPal Account

If you do not have a pre-paid student access code and would like to purchase access with either a credit card or PayPal account, select the button that appears with a price listed under Use Credit Card or PayPal.

On the Payment page, select your Payment Method. Then enter your credit card or PayPal account information, your full billing address, and your email address. Click Review to verify your payment information.

NOTE: The total including applicable tax will be charged to your credit card. This charge will appear on your account statement as Pearson Education.

On the Review page, you can:
- Change your payment information
- Change your billing information
- Select Help if you need additional assistance with this page
- Click Cancel if you do not want to make this purchase

Select Make Payment to complete your purchase.

NOTE: When you select Make Payment, your credit card or PayPal account will be charged.

Once your credit card or PayPal account has processed the payment, a registration confirmation page will appear. You are now registered and enrolled in your MyLab course. To get started, click Go to Your Course.
**Option 3 - Getting Access Without Payment for 14 Days**

If you are waiting on financial aid to make course material purchase, you can get temporary access to your MyLab course without payment for 14 days.

At the bottom of the Registration page, click on the Get **Temporary access without payment for 14 days** link.

A Temporary Access pop-up box will appear asking if you are sure you want temporary access. Select **Yes**.

Once the temporary access has been processed, a registration confirmation will appear. You are now registered and enrolled in your MyLab course. To get started, click **Go to Your Course**.

**NOTE:** Temporary access allows for unlimited access to your MyLab course for 14 days. You will receive three (3) alerts via email indicating how much time you have left until your temporary access expires. Once you are ready to make payment, simply click on the link in one of your email alerts.

---

**Register**

Select an Option

**Use an Access Code**

A prepaid access code might come with your textbook or in a separate kit.

- MyLab/Mastering
- Access Code

**Use a Credit Card or PayPal**

- New MyDevelopmentLab for Feldman, Child Development, 6e w/ eText
  - $93.5 USD
  - New MyDevelopmentLab for Feldman, Child Development, 6e
  - $88.8 USD

*Waiting for financial aid? Get temporary access without payment for 14 days. Use an access code, credit card, or PayPal before August 8, 2012 to stay in your course.*
To get full access to your MyLab course after registering with temporary access, you must use an access code, a credit card or PayPal account. Here’s how:

2. Click **Sign In** and enter your previously created Pearson account username and password.

**NOTE:** Make sure you upgrade from your existing Pearson account. Creating a new username/password will cause your grades from the first 14 days to be unavailable to you.

3. Click **Pay** or **Use an Access Code Now** link under your course.

**NOTE:** If you temporary access has expired, you may see an expired notice. After clicking **Pay** or **Use an Access Code Now** link from the expired notice, you will be asked for the Course ID.

4. Select **Payment** option.
   - If you purchased a student access code, click **Access Code**, enter the access code in the boxes, and click **Finish**.
   - To use a credit card or PayPal, select the desired option. Enter the billing and payment information, and then click **Review** and **Make Payment**.

You are now set for the rest of the semester. From the confirmation page, click **Go To Your Course**, and in the left column, click the course name to continue to your MyLab.
MyPearson PORTAL

After signing in, your MyPearson portal page will appear. This page is the central location for all your MyLab/Mastering courses and Pearson resources.

This page consists of the following areas:

- **MyLab/Mastering New Design** - Lists all the MyLab/Mastering New Design courses in which you are currently enrolled

- **Announcements** - Displays general announcements from Pearson Education and provides timely information about each of your courses

- **Your Courses and Products** - Helps you manage your Pearson Product subscriptions

- **Need Help?** Provides links to information about working within your Pearson courses

The top right corner of the MyLab/Mastering Courses page provides links to:

- **Edit Profile** - Enables you to manage your Pearson account by editing your personal information

- **Help and Support** - Opens a page with links to online Student Help and support resources

- **Sign Out** - Ends your session
GETTING STARTED
At the TOP of your Course Home page, you will find the GETTING STARTED banner.

Before you do anything in your MyLab course, you MUST COMPLETE the two GETTING STARTED steps below.

1. **Tune Up Your Browser:** Click and complete the **Tune Up Your Browser**.

   **NOTE:** You must have ALL green checkmarks in order to confirm that your computer’s browser is supported and that you have all the necessary plug-ins for maximum functionality of the site’s resources.

2. **Sync Your Time Zone:** Click and set your **time zone** on your student profile (i.e., the time zone of the location where you will be completing assignments).
COURSE NAVIGATION

On your Course Home page, you will see the Course Menu, or Navigation Bar, on the left side of the page. These are the tabs you will use to navigate through your course.

eText & Chapter Audio

If your registration includes access to the eText, you will find the complete and interactive eText here.

Basics:
- Includes full Chapter Audio—just look for the audio icon at the beginning of each chapter
- Take notes and highlight within the eText
- Compatible with the iPad and Android tablets by downloading the FREE Pearson eText app and using your MyLab login/password for access.

To access the app for iPad:
www.pearsonhighered.com/etextmobile/etextforipad/

To access the app for Android tablet:
http://www.pearsonhighered.com/etextmobile/etextforandroid/index.html

More detail:

Beyond providing perfect fidelity to your printed textbook, the Pearson eText platform offers many easy-to-use features. Depending on your text, such features include intuitive navigation controls, glossaries, enhanced searchability, personal highlighting, bookmarks and note-taking.

- How to Search Within the eText: A search box is located at the top of the page. Click on it and enter your search terms to easily find pages that contain the term you are searching for. Use the “Limit Results To” drop-down menu to drill down to particular chapters and narrow your search.

- How to View Recent Searches: To review your most recent search results, click on “My Searches”. Your search history will be displayed on the left-hand side of the screen.
• **Highlight**: Highlighting allows you to mark up the book as much as you want while studying. Click on the Highlight tool along the top navigation and select the text you wish to highlight. To show or hide your highlights, click the drop-down arrow to the right of the Highlight tool, and select show or hide highlights. Your instructor may also include highlights in your text, and these will be indicated in a different color on your screen.

![Highlight tool](image)

• **Take Notes**: Click on the **Note** icon, which looks like a pushpin. Click the area in the eText in which you want to make a note. To delete your note, double-click and click **Edit** then **Delete**.

You can access your notes via the Notes Manager by clicking the drop-down arrow to the right of the **Note** (Pushpin) icon. Notes Manager will allow you to search for your notes, export them to your desktop, and print them so they can be used as a study guide.

• **Bookmark**: Use the **Bookmark** tool to mark an important page. Click on the **Bookmark** tool to mark the current page you are viewing.

If you want to view all of your bookmarks, click “Bookmarks” on the left-hand navigation of your eText, typically located underneath the Table of Contents section. To delete a bookmark, go to the marked page and click on the Bookmark tool on the top navigation.

• **Print**: To print a single page or two facing pages in an eText:
  1) Navigate to the page or facing pages that you wish to print
  2) Click the **Print** button
  3) Enter settings in the print dialog box, as needed, and click **Print**.

![Print dialog box](image)
**Assignment Calendar**

Your instructor may opt to assign required coursework to the Assignment Calendar. You can quickly and easily access your assignments from this calendar.

**Basics:**
- **Blue clock** icon on the calendar indicates that an assignment is due **on that day**
- To access assignments from the calendar, click on the **blue clock**—the assignments will appear in a list to the right of the calendar
- Click on any assignment in the list to begin

**More detail:**
When you log into your course, you can find your required assignments by clicking on the **Assignment Calendar**.

By default, the Assignment Calendar displays the current month with the current day highlighted. You navigate forward and backward in the Assignment Calendar by clicking ➤ or ◀.

You can launch directly into your assignment by clicking on the icon. Your assignment will appear to the right of the calendar. You can click directly on the assignment to begin working.
The following details can be viewed in the Assignment Calendar:

- **Completed**: The date on which you completed and submitted the activity to the instructor. This will be displayed as the icon.
- **Items Due**: When a due date is set for an activity, the date is marked with the icon. This means that you have to submit the activities on or before the date specified.
- **Items Past Due**: If an activity is not submitted on or before the due date, the date is marked with the icon. If the instructor accepts the submission of the activity after the due date, the icon is replaced by the icon.
- **Note**: Any note or information added for a date is marked with the icon.
- **Submitted**: The date on which you submitted an activity that needs manually graded by a professor (usually short answer). This assignment is marked with the icon.

**Completing an Assignment from Your Assignment Calendar**

It is highly recommended that you monitor your assignment calendar on a regular basis so that you can manage your time and complete your assignments by the date that they are due. As identified above, a blue clock on your calendar means that you have an assignment(s) due that day.

**IMPORTANT!** Assignments that are completed past the due date and time will be classified as “past due” and will result in an automatic zero. Your instructor will determine if the late work is accepted.

**To Access and Complete an Assignment:**

- From your Assignment Calendar, locate the date your assignment is due. (Your calendar will display all activities that are due that day)
- Click on the Assignment and begin.
How the Study Plan Works

The Study Plan is a 3-step assignment—Pre-Test, Study Material, and Post-Test.

1. After reading the assigned material, you take the Pre-Test, which is a multiple choice online quiz that can only be taken once.

2. Based on your results of the Pre-Test, the MyLab creates a personalized Study Plan, which is a list of multimedia activities. Multimedia assets are used to present the same content but in a visual manner. Additionally, Formative Assessment questions are included to check comprehension of the activity completed and to provide contextual feedback in the learning moment.

3. Finally, you will complete the Post-Test, which should allow you to demonstrate mastery of the text material. **If you do not achieve the pass criteria of the Post-Test, then the Study Plan will remain in progress.**

**NOTE:** Any work completed from this tab will report to your instructor’s gradebook.
**Study Plans & Course Content**
You will find multiple types of assignments (chapter objectives, exams, quizzes, media links, media assignments, etc) available for self-study. To navigate **Study Plans & Course Content**, click on any chapter and drill down to locate practice assignments and resources.

![Study Plans & Course Content](image)

**NOTE:** Any work completed from this tab will report to your instructor’s gradebook.

**Student Resources**
These resources vary by discipline but will always include the resources listed below.

- **Flashcards:** These flashcards include the key terms from your textbook along with an adaptive speed-drill for proficiency.
- **MySearchLab™:** Pearson’s MySearchLab™ gives you all of the tools you need for writing and research in one convenient location, including four databases of credible and reliable sources.
**Student Grades**

Your Gradebook keeps track of progress in the course. All auto-graded assignments and activities are recorded here, as well as in your instructor’s Gradebook.

**Basics:**
- The default filter for your grades is **Assigned Items**. This means that you will only, by default, see the grades for work that was assigned to the Assignment Calendar by your instructor.
- If your instructor indicates that a **Custom View** has been created, you may view the **Custom View** by clicking on Custom View at the top left of your gradebook.
- To locate your grades, drill down by chapter in the **Course Materials** menu on the left side of the gradebook.

**More detail:**
**Filters**

Use the buttons above the grades list to select your filter. Options are:
- **All items**: Display all activities in the course.
- **Completed items**: Display only those activities that you have submitted.
- **Assigned items**: Display only assigned activities.

**Note**: A maximum of 50 assignments can appear on one page. Use the navigation at the bottom of the page to view additional assignments or to select a page to view.

**Grades List Columns**
The grades list consists of the following columns:
- **Activity**: Displays the name of the activity and, possibly, this icon 📜, which means the activity will be manually graded by your instructor.
- **Grade**: Displays your grade for the activity. If your instructor added grade comments, you can click the feedback icon 📒 to view them. The column may contain the following icons for submitted activities:
  - The grade history icon 📒 indicates that your instructor edited the grade. Click the icon to view grade history details.
  - 📒 **Submitted Late**: Indicates you submitted the activity after the due date/time. Your grade appears in gray and is not counted for any averages or included in any reports. However, if your instructor accepts your late submission, extends the due date to a date in the future, or edits the grade, the grade is counted normally and the icon is removed.
  - 📒 **Requires manual grading**: Your instructor needs to grade the activity manually because it contains either essay or file upload questions.
  - 📒 **Not Passed**: Indicates you did not receive a passing grade for the activity.
  - 📒 **Not Started**: Indicates you have not yet attempted the activity.
  - 📒 **New Grades**: Indicates the grade was posted since you last opened the Grades page. The icon only appears when you view the page for the first time after the grade is posted.
  - 📒 **Grace Period**: Indicates your score was automatically reduced because you turned in your work after the due date. This icon does not appear on the Grades > Custom View page.
  - **Pending**: Only available for activities that contain questions that require manual grading. The pending status appears until the instructor grades all the questions in the activity or until the instructor edits the activity grade.
• **Class Average**: The last column in the grades lists is **Class Average**, which shows the average grade for all students in your course. The class average is provided for assigned items you have submitted for grading. The **Class Average** column calculations use the following rules:
  o Assignments that are not yet due and that you have not submitted are not counted in the average.
  o Assignments that are past the due date and that you have not submitted are counted as a zero in the average. Your instructor can change the grade from zero by accepting a late submission, extending the due date, or manually editing the grade.
  o Assignments that you submitted after the due date are counted as a zero unless the instructor accepts the submission, edits the grade, or extends the due date.
  o Assignments that were assigned without a due date are considered due on the last day of the course, and all of the rules above apply.

**Note**: This column is available at your instructor's discretion and may not appear in your courses.
How to Locate Study Plan Grades
To locate your grades for completed assignments, you must first locate the chapter of the assignments in your Gradebook.

If you completed the Study Plan, your grades will automatically appear.

To view your Study Plan grades, click on View Grades. The results of your Pre-Test and your most recent Post-Test will appear.

To view your Pre-Test or your Post-Test submission, hover over the desired test to activate the arrow for the drop-down menu. Select View Submissions.

You can now see the submission, including your responses, the correct answers, and feedback with page references to your textbook.
How to Print a Copy an Assignment

Many students like to print a copy of their completed chapter exam to either use it as a study tool, or to provide their instructor should he or she desire a hard copy.

1. In your Gradebook, locate the appropriate chapter in the Course Content panel on the left side of the page.
2. If you completed the assignment, your grades will automatically appear.
3. Hover over the desired assignment to activate the arrow for the drop-down menu.
4. Select View Submissions.
5. You will then see a Submission List, from which you can access your assignment.
6. Click on the printer icon in the top left corner.
**Communication Tools**
This tab includes options for discussion boards, chat and ClassLive sessions, and e-mail. If your instructor is not using these features, this tab may not appear on your Course Menu.

**Email**
Use the internal email feature to message your instructor and classmates from your MyLab course. You can choose to send a message to one or more recipients and include attachments if desired.

**Discussion**
Your instructor can post discussions so that you can respond and share ideas with your classmates. When you respond to another post, it starts a threaded discussion.
- To respond to a discussion topic or thread, click Respond beneath the subject or thread you want to respond to.
- For Subject, enter the title of your response and use the content editor to add your response.
- For Attachments, click Add/Remove link. In the Add and Remove Attachments page, under File to attach, browse to the file to be attached. Click Attach File or Save & Attach Another File.
- Click Preview to verify your response, or Post Response to submit your response immediately. Your response will now be displayed in the topic thread you selected.

**ClassLive**
ClassLive is an Instructor-led interactive chat tool that allows you to communicate with your classmates and instructor in real time. For example, you can place or draw objects on the whiteboard and share a software application from your computer.

**To Join a ClassLive session:**
Under Communication Tools, click Chat&ClassLive.
- Click ClassLive
- Click Join Session
- You will then be asked to run the Elluminate Live! Software. Once the software has been launched, read and accept the license agreement and then select your connection speed.

The Participants panel provides you with an overview of what is happening within the session.

Inside the Chat window, you will be able to share messages with other participants.
- Select the Help menu in the Elluminate Live! Window for further assistance.
- To end the session, select File>Exit or close the window.
TRAINING AND TROUBLESHOOTING RESOURCES

For additional training resources, please go to the SUPPORT tab of your MyLab:

- MyAnthroLab  [www.myanthrolab.com/support](http://www.myanthrolab.com/support)
- MyArtsLab  [www.myartslab.com/support](http://www.myartslab.com/support)
- MyHistoryLab  [www.myhistorylab.com/support](http://www.myhistorylab.com/support)
- MyMusicLab  [www.mymusiclab.com/support](http://www.mymusiclab.com/support)
- MyPoliSciLab  [www.mypoliscilab.com/support](http://www.mypoliscilab.com/support)
- MyPsychLab  [www.mypsychlab.com/support](http://www.mypsychlab.com/support)
- MyReligionLab  [www.myreligionlab.com/support](http://www.myreligionlab.com/support)
- MySocLab  [www.mysoclab.com/support](http://www.mysoclab.com/support)
1. **Browser Tune-Up**: Run the Browser Tune-up located on the home page of your MyLab course. Please note that you MUST have ALL green checkmarks in order for your MyLab to work properly. We strongly recommend the use of **FIREFOX** for both Macs and PCs.

**IMPORTANT!** It is very important that you complete **Step 1** and **Step 2** under the **Getting Started** banner on the course home page. This will ensure you are using the correct browser and have the proper versions of the necessary applications on your computer. It will also make certain that you are set up to the appropriate time zone so that your time zone is in sync with your instructor’s course.
2. **Accept Cookies and Clear Your Cache**: If you close your browser without logging out or use more than one account in the same browser, conflicting login information ("cookies") may be stored in the browser.

Deleting the temporary Internet files and cookies that have been stored by your browser commonly corrects these problems. Please complete the instructions below for the browser you are using.

If you do not know what version you are using, open your browser and click **Help > About [browser name]** to see your version number.

- **Internet Explorer 9 or 10**
- **Chrome**
- **Safari 6**
- **Safari 5 or Earlier**
- **Firefox**
- **Still Having Trouble?**

Because we strongly recommend Firefox, please find the appropriate steps below.

<table>
<thead>
<tr>
<th>FIREFOX:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Close all Firefox windows.</td>
</tr>
<tr>
<td>• Open a new Firefox session and click <strong>Tools &gt; Clear Private Data</strong>... (or <strong>Clear Recent History</strong>...).</td>
</tr>
<tr>
<td>• Be sure that there is a check in the box beside Cache and also in the box beside Cookies (or select <strong>Everything</strong>).</td>
</tr>
<tr>
<td>• Click <strong>Clear Private Data Now</strong> (or <strong>Clear Now</strong>).</td>
</tr>
</tbody>
</table>

**NOTE**: This may take a few minutes to process. Please wait for the files to delete before you continue.
3. **Advanced Settings Guide:** If you have performed the Browser Tune-Up AND you’ve cleared your cache and accepted cookies, please complete the Advanced Settings Check. *This will solve 95% of the “I can’t open/submit” issues.* Because we recommend Firefox, please find the instructions below.

**FIREFOX:**

**Allowed Add-Ons**
Firefox features a security setting that affects whether the capabilities of the browser can be extended. Please follow the instructions below to be sure that add-ons required for Pearson web sites can be installed:

- **In Windows:** Open Firefox and click **Tools** (if you do not see Tools, press the Alt key to show the menu bar)  
  **In Mac OS X:** Open Firefox and click **Firefox**
- **In Windows:** Click **Options**  
  **In Mac OS X:** Click **Preferences**...
- Click the **Security** icon at the top of the window
- Beside "Warn me when sites try to install add-ons," click the **Exceptions**... button to open the Allowed Sites - Add-ons Installation window
- Where it says "Address of web site," type the following addresses, clicking **Allow** after each one:
  - pearsoned.com
  - pearsoncmg.com
  - ecollege.com
- After adding those sites, click **Close**
- Click **OK**
Pop-Up Blockers
Firefox features a pop-up blocker that can prevent new windows from opening. Please follow the instructions below to be sure that new windows that open on Pearson web sites are not blocked:

- **In Windows:** Open Firefox and click **Tools** (if you do not see Tools, press the Alt key to show the menu bar) **In Mac OS X:** Open Firefox and click **Firefox**
- **In Windows:** Click **Options** **In Mac OS X:** Click **Preferences**...
- Click the **Content** icon at the top of the Options window
- Beside "Block pop-up windows," click the **Exceptions...** button to open the Allowed Sites - Pop-ups window
- Where it says "Address of web site," type the following addresses, clicking **Allow** after each one:
  - pearsoned.com pearsoncmg.com ecollege.com
- After adding those sites, click **Close**
- Click **OK**

Many toolbar add-ons (including Google and Yahoo toolbars) use pop-up blockers and may need to be disabled while you are using the site. For complete instructions on how to disable an add-on, please visit [http://support.mozilla.com/en-US/kb/Uninstalling%20add-ons](http://support.mozilla.com/en-US/kb/Uninstalling%20add-ons)

Some add-ons can be disabled by following the instructions below:
- Open Firefox and click **View** (if you do not see View, press the Alt key to show the menu bar)
- In the View menu, click **Toolbars**
- Uncheck any toolbar that includes a pop-up blocker (such as Google Toolbar or Yahoo! toolbar)

**NOTE:** The menu will close after each item you choose, so you will have to repeat these steps for each toolbar that includes a pop-up blocker.
Cookies
Firefox features privacy settings that affect what data your computer accepts from web sites. Please follow the instructions below to ensure that data from Pearson web sites is not blocked:

- **In Windows:** Open Firefox and click **Tools** (if you do not see Tools, press the Alt key to show the menu bar)  
  **In Mac OS X:** Open Firefox and click **Firefox**

- **In Windows:** Click **Options**  
  **In Mac OS X:** Click **Preferences**...

- Click the **Privacy** icon at the top of the window

- In the drop down menu beside "Firefox will," chose **Use custom settings for history**

- Click **Exceptions**...

- Where it says "Address of web site," type the following addresses, clicking **Allow** after each one:
  
  - pearsoned.com pearsoncmg.com ecollege.com

- After adding those sites, click **Close**

- Click **OK**

4. **Security:** Set your Browser Security to Medium.

5. **Wi-Fi:** If you are using a wireless connection, please make sure that you have a strong and stable connection. If your wi-fi drops—even for a split second—it will cause an interruption in your work, which can result in an error. It is best to work via a hardwire connection. If you believe this may be the issue for your interrupted work, please inform your instructor.

6. **Media (videos, etc.) Issues:** If you have completed the Browser Tune-Up and the Advanced Settings steps and you are still unable to view the videos in your course, there may be an issue with the plug-in or add-on required for the videos. Please use this link for add-on help:

   [http://247pearsoned.custhelp.com/app/answers/detail/a_id/7563](http://247pearsoned.custhelp.com/app/answers/detail/a_id/7563)
7. **24/7 Customer Support**: If you are still experiencing trouble, please contact Pearson Customer Support using the **24/7 Customer Support** button on the left-side navigation bar of your course home page. When using chat or email, make sure to follow directions for providing your user and session information to the customer support agent at [http://247pearsoned.custhelp.com/](http://247pearsoned.custhelp.com/).

**IMPORTANT!** If you experience any unexpected messages or functionality during a session of MyLab, please capture the **User and Session Information**. Note that this is only useful during the same session. If you log out and log back into get the information, we will be missing the key data. From the various bits of information, we can reconstruct what happened more effectively and provide more timely support and resolution.

---

**24/7 Customer Support**

- **ONLINE KNOWLEDGE BASE**: Find the help you need. Use the Answer Wizard to find the answers you’re looking for — fast!
- **Can’t find your answer? Our MyLabs Pearson 24/7 customer support team is ready to help.**
- **USER AND SESSION INFORMATION**: Before you contact Pearson 24/7 customer support, click to to access information specific to your account for faster support. Copy and paste this information into your chat window or email.
- **24/7 CHAT**: Chat with a support representative. Remember to copy and paste your user and session information into the chat window.
- **24/7 EMAIL**: Submit a help request form. Remember to copy and paste your user and session information into the question field of the form.

---

**Pearson Education Customer Technical Support**

Contact Technical Support: [247pearsoned.custhelp.com](http://247pearsoned.custhelp.com)

Provide all the information shown below to the support representative

- **URL**: /Pegasus/Modules/TeachingPlan.Calendar/fmAssignContent.aspx
- **BuildNumber**: 3.3.228.2
- **Login name**: newmypsychlab
- **Session Id**: d2t0qplvk4kt0545331m4nw
- **Product**: Not Available
- **Course**: MyPsychLab for Ciccarelli and White, Psychology 3e
- **Course ID**: CRSCDYP-86259
- **Operating System**: Macintosh MacOSX
- **Browser**: Safari(534.48.3)
- **Server name**: PEGFEPRODV22

**Copy/paste into email to Pearson**
How to Retrieve your Pearson Login Name and Password

If you have registered for a Pearson website and now you either cannot login in, or you can login but you don’t see your course, you may be using the wrong Login Name and Password.

**Step 1** - Go to: [https://register.pearsoncmg.com/forgotlogin/forgotLogin.fl](https://register.pearsoncmg.com/forgotlogin/forgotLogin.fl)

**Step 2** - In the first box enter **ONLY YOUR EMAIL ADDRESS** (do NOT include your Login Name) then click “Send My Login Name and Password”, as shown below.

![Login and Password Assistance](image)

**IMPORTANT:** If you may have used another email address when registering, such as a school email, or a yahoo or gmail account, return to [https://register.pearsoncmg.com/forgotlogin/forgotLogin.fl](https://register.pearsoncmg.com/forgotlogin/forgotLogin.fl) and repeat Step 2 by entering any other email address you may have used.

**Step 3** – Go to your email and look for an email from “product.support@pearsoned.com” this will contain your login name(s) and password(s) (make sure you check any other email accounts you may have entered)

When you open the email from product.support@pearsoned.com look at it carefully as you may have more than one Login Name and Password combination from different Pearson websites as shown below:

![Login Name and Password](image)

**Try each combination.** When you find the correct one write it down!

If you are still not able to locate the correct Login Name and Password please contact Tech Support: [http://247pearsoned.custhelp.com](http://247pearsoned.custhelp.com)
How to Contact Pearson Customer Technical Support

You will find an FAQ database, as well as contact information for our Customer Technical Support team. They can be contacted either by phone, e-mail, or chat.

**800-677-6337**

**http://247.pearsoned.com**

When Pearson 24/7 Customer Support is contacted, an “Incident Report Number” is issued. Please keep record of this number and/or any transcripts, so that we may properly track your issue.

---

**IMPORTANT!** If you experience any unexpected messages or functionality during a session of MyLab, please capture the User and Session information. Note that this is only useful during the same session. If you log out and log back into get the information, we will be missing the key data. From the various bits of information, we can reconstruct what happened more effectively and provide more timely support and resolution.
<table>
<thead>
<tr>
<th>URL:</th>
<th>/Pegasus/Module/TeachingPlan/Calendar?ImAssignContent.aspx</th>
</tr>
</thead>
<tbody>
<tr>
<td>BuildNumber:</td>
<td>3.3.228.2</td>
</tr>
<tr>
<td>Login name:</td>
<td>newmypyschlab</td>
</tr>
<tr>
<td>Session Id:</td>
<td>c2xxxyvkl-k4t054533im4nw</td>
</tr>
<tr>
<td>Product:</td>
<td>Not Available</td>
</tr>
<tr>
<td>Course:</td>
<td>MyPsychLab for Ciccarelli and White, Psychology 5e</td>
</tr>
<tr>
<td>Course ID:</td>
<td>CRSCDYP-86250</td>
</tr>
<tr>
<td>Operating System:</td>
<td>Macintosh MacOSX</td>
</tr>
<tr>
<td>Browser:</td>
<td>Safari(534.48.3)</td>
</tr>
<tr>
<td>Server name:</td>
<td>PEGFEP/CCDV/22</td>
</tr>
</tbody>
</table>

Copy/paste into email to Pearson